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1.1

1.2

Window Glass Design 2004
Introduction

Standards Design Group, Inc. developed a Basic package of Window Glass
Design 2004 to perform window glass Load Resistance and Deflections in
accordance with ASTM E 1300 1994, 1998 or 2004 standard. Standards
Design Group, Inc also worked with leading glass professionals to go beyond
the standard and offer with its Standard and Deluxe packages Non-
Rectangular lite shapes, Theoretical Load Share Factors as developed by C.V.
Girija Vallabhan and new interlayers developed by Saflex® HP and
SentryGlass® Plus. The Glass Association of North America endorses the
Window Glass Design 2004 program as being the best tool available to aid in
designing window glass to resist wind and long-term loadings.

Features

Window Glass Design 2004 operates in a Windows™ environment with easy to
follow design input windows. The user inputs the shape, dimensions, angle,
number of supported sides and glass design and Window Glass Design does
the rest. The program even allows the user to toggle between US and Sl
units.

Window Glass Design 2004 Calculates the load resistance for single or double
glazing insulating glass units constructed with monolithic or laminated glass
lites. The user can define each lite as annealed, heat strengthened or fully
tempered. The program also allows symmetric and asymmetric laminated
glass. Interlayers for the laminate glass include PVB, Saflex® HP and
SentryGlass® Plus.

One change made for the 2002 — 2004 ASTM E 1300 standard was the short
duration load. Earlier editions defined the short duration load as a 60 second
load where the new standard requires a 3 second short duration load. Wind
Load design produces a 3 second gust load that now can be directly input in
the new standard but if an earlier standard is requested for design a Load
Converter is provided to change the load from 3 second to 60 second and
anything in between.

The program returns the load resistance and approximate center deflection
for the design. It also will inform the user if the design passes or fails the
required loading with easy to identify green (pass) or red (fail) script.
Clicking on a details button will display the Non-Factored load and Glass Type
Factor used to calculate the Load Resistance. Another click and the user is
provided the actual Non-Factored Load chart. The print out of the Project
Report is consistent with ASTM E 1300 and suitable for presentation to a
building official. The Details Report displays the glass shape and angle as well
as the Non-Factored Load, Glass Type multiplier and the Non-Factored Load
Chart.



2.1

2.2

2.3

Getting Started
Opening Window Glass Design 2004

Window Glass Design opens in two ways. The user can follow the path Start
> All Programs > Standards Design Group, Inc > Window Glass Design 2004
or the user can navigate to a file with the extension “.gla”.

Starting a New Design

The program starts with a new design window already open and ready to
begin. If a user wishes to open a new project after working with an already
open design there are two options: first is to click on File > New Project and
the second is clicking on the “New Project” button on the toolbar. These
options are displayed in Figure 2.1.

Window Glass Design 2004 -- Window Glass Design 2004 --

File Input Tools Window Help Big Input Tools Window Help
New Project m == < ) & s jus s M
Open Project,,,  Chr+O

04 Glass Design 2004
Save Project Chrl+5

Save Project &s... | [ Dezign Standard -
Figure 2.1 Opening a New Design

Opening a new design will reset all the values in the current design to the
default values. If an ASTM Compliant or Advanced Glazing Input window is
open a new ASTM Compliant window will open. If a Multiple Glazing Input
window is open a new Multiple Glazing Input window will be provided.

Opening an Existing Design
When Window Glass Design 2004 is opened, the program provides three

methods for opening a saved file. The user may use the Main Menu File >
Open Project or use the “Open Design” button on the toolbar, Figure 2.2.

Window Glass Design 2004 -- Window Glass Design 2004 --
Fﬂa Input Tools Format Window H Eile,hwt Tools Format  Window He

Mew Project ] | us sl

bt A 2 us st |

Save Project Chrl+5

Save Project As...
Figure 2.2 Opening an Existing Design




These options will open a new window from which the user can navigate and
click on the file they wish to open, see Figure 2.3. When the desired file is

selected, click Only files with the extension “.gla” are displayed in
this window.

Open E]
Look jn: |_; Sample Glass Design Folder ‘j & I‘j‘ EE-

Recent

|

Desktop

&

My Documents

i,

My Computer
g | |
My Network File name: IDesignE.gIa LJ Open |

Places

Files of type: I Diesign [7.gla) LJ Cancel

Figure 2.3 Select an existing window glass design

If the file was recently used the name of the file will appear at the bottom of
the File menu. Clicking on the file name will open the selected file and
refresh the input window, Figure 2.4.

Window Glass Design 2004 -- |
File Input Tools ‘Window Help

Mew Project I‘ﬂ +
Qpen Project. .. Chrl+0 —
Save Project Chrl+5 F(M

Save Project As, .,

e
Prink 3 'E

Prink Previaw k

Praject Info

1 Designd.gla —
2 Diesigri. gla

Exit
Figure 2.4 Recent File Menu

If the file you selected on the Recent File Menu has been moved or otherwise
unable to be opened by the program, the file name will be removed from the
list and a warning will notify the user of the error.



2.4 Saving a Document

To save the current project click on File > Save or File > Save As or click on
the “Save Design” button on the tool bar, Figure 2.5.

Window Glass Design 2004 -- De Window Glass Design 2004 -
Fila Input Teols “Window Help File Input_Tools “Window Help

Mew Project 'n + ) S E | ﬁq
Chrl+0

Qpen Project, .,

R Windo{save Design}ien 2004

Save Project 4s...

Design Standard

Print = [A5TH F130Nn2N3 =
Figure 2.5 Save the Current Project

A “Save As” window will open, Figure 2.6, and the user may name the file and
save it to the desired directory. When the user is finished naming the file,

select
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Figure 2.6 “Save As” Directory Window



When a file is saved, the Recent File Menu will be updated and the current file
name will appear at the top of the list, Figure 2.7.

Window Glass Design 2004 -- | Just Si
File Input Tools ‘Wwindow Help

Mew Project |
Open Project. .. Crl+0
Save Project Ctrl+s
Save Project As...

Print » ]
Print Preview »

Praject Info
1 I Just Saved This.gla zl
2 Designd.gla
3 Designé.gla

Exit
Figure 2.7 Updated Recent File Menu

2.5 System of Units

All of the programs produced by Standards Design Group, Inc provide the
user with the option of US or Sl units and Window Glass Design 2004 is no
different. To toggle between desired design units the user may select from
Tools > System of Units on the Main Menu or click the unit’'s button on the
tool bar, Figure 2.8.

Window Glass Design 2004 -- | Just Sa Window Glass Design 2004 -- 1 Just S
Fie Input Toolks Window Help Bile Input Tools s Help
S E—L.;,,ad Carwverker l+ RS2 = I o+
| Windo m; s :' .3 :IS _! Window Glass
IIE Defaulk Values | = Design Standard
MxeTia c1onn m = | |45TM E1300-02/03 -

Figure 2.8 System of Units Selection

When a new system of units is selected, the input windows will immediately
update and convert values to fit the new system.



2.6

2.7

Language

Window Glass Design 2004 is equipped with a new option that will allow users
to choose a language for their program. Currently, Chinese and English are
the only languages provided. These languages will only display properly if the
Windows™ system installed on the same computer as the Window Glass
Design 2004 program supports the language desired. To select a language go
to Tools > Language as seen in Figure 2.9.

Window Glass Design 2004 [ Design4.gla ]
File Input Tools Window Help
3 o E Load Converter +

System of Units » |
Language ¥ Enaglish

Windo

Design g Default Yalues Chinese G
|45TM E1200-02/032 wl .

ey |

Figure 2.9 Select a Language

Default Values

This option changes the default value for various parts of the program.
Figure 2.10 shows the Default Values window. The user can option the
System of Units to always select Sl units when a new project is opened. The
“Show Grid Lines” and “Grid Alternating Color” refer to the Multiple Glazing
Input window. If the default values are changed, these changes will take
place when the Window Glass Design 2004 program is loaded again.

Default Values g@
System OF Units: |SI| j
Show Grid Lines: |N-:| j
Grid Alternating Color: |Fied j

Apply | Cancel |

Figure 2.10 Default Values Window



2.8

Load Converter

One change made for the 2002 — 2004 ASTM E 1300 standard was the short
duration load. Earlier editions defined the short duration load as a 60 second
load where the new standard requires a 3 second short duration load. Wind
Load design produces a 3 second gust load that now can be directly input in
the new standard but if an earlier standard is requested for design the Load
Converter is provided to change the load from 3 second to 60 second and
anything in between.

Example: A window is designed for a wall and the 3 second gust speed is
20psf. The desired ASTM E 1300 standard is the 2000 and therefore requires
a 60 second short duration load input. Navigate to Tools > Load Converter
and enter the information as shown in Figure 2.11.

Load Converter E]@1

Ingt Losdd Informestion

Load 20 paf
Duration O L
Oulput Load

Duration 60 |Sec -
Load 166 psf

Calculste | Done |

Figure 2.11 Load Converter Window

When your Input Load Information has been entered as well as the Output
Duration, clicking will display the desired load value, in this case
16.6 psf.



2.9 Project Information

The “Project Information” window, Figure 2.12, contains reference information
about the design project that includes the project name, location, design date
and designer. The window provides a field for comments and other
information relevant to the project. The data entered are for the user’s
information only and will be displayed on the printed reports. Window Glass
Design 2004 does not require this data for design calculation.

Project Information E] — 1
Fraject Name: |Glasz Design Example
Locatior: |Lubbock, T
By |SDG Tech1
Start D ate: m
Comments:

Thisg iz an input example for the help manual.

Done |

Figure 2.12 Project Information window

2.10 Printing a Document

Window Glass Design 2004 prints a detailed report suitable for presentation to a
building official. It allows the user to print a detailed report on the information
used from ASTM E 1300 to calculate the Load Resistance and Deflection in the
Print Details Report as well as all the input information and calculated results in
the Print Project Report option, Figure 2.13.

Window Glass Design 2004 [ Designd.gla |
File Input Tools ‘“Window Help

Mew Project
Cpen Project,,, CErl4+0
Save Project Chrl+5
Save Project As.., 4
Print: L3 Print Project Report Con
Print Preview r Print Details Report |

N ol S G
Project Info {J [os

" Cande

Figure 2.13 Print Options on Main Menu



2.10.1

2.10.2

2.10.3

Print Details Report

The “Print Details” option provides a two page report that includes a
sketch of the lite shape, dimensions and angle and calculation details.
The calculation details include the Non-Factored Load, Glass Type
Factor, Load Resistance and Approximate Deflection for the Short
and/or Long Duration Loads for each lite. The second page of the
Details Report is the Non-Factored Load Chart for each lite.

A sample Details Report can be viewed in the Appendix section of this
manual.

Print Project Report

The “Project Report” option contains all the input information: Glazing
Information, Glass Construction, Short and Long Duration Load,
Resistance and Deflection, Conclusions and Compliance Statement.
This is also where the “Project Information” will be displayed.

A sample Project Report can be viewed in the Appendix section of this
manual.
Print Window

To print a document, click on File > Print and either Print Details
Report or Print Project Report in the Main Menu, refer to Figure 2.13.
When a report option is chosen the Print Window will appear, Figure
2.14. Select the current printer and press the to print the
desired report. Print Windows may differ between Windows ™
releases.

Print @

Prirter

Hame; Wedg-dom1WHF C Lazer)et 45600 LJ Properties. ..

Status: Ready
Type: HP Calar Lazerlet 4550 PCL &
Where:  Workroom

Comment; I Print ta file
Frint range Copies-

s Al MNumber of copies: ﬁ?
e P o[ T

=
[ 5
ok | Cancel

Figure 2.14 Print Window




2.10.4

Print Preview

Window Glass Design 2004 provides a “Print Preview” functionality.
Similar to the “Print” option, there are two reports in which to preview:
Details Report and Project Report. These reports will appear exactly
how they will print. When the user selects File > Print Preview and
either Print Details Report or Print Project Report in the Main Menu a
new window will open with the image of the selected report, Figure
2.15.

Window Glass Design 2004 [ Design4.gla ]
File Input Tools ‘Window Help

Mew Project
Cpen Project, .. Chrl4+0
Save Project Chrl+5
Save Project As... 04
Prink 3
Prink Preview L] Preview Project Report

) Preview Details Report Glaze
Project Info

—Single Lite

1 Designd.gla
2T Tk Sawad Thic ala — Glass Typ

Figure 2.15 Print Preview Selection
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Input Options

There are three input windows available to the Window Glass Design 2004 program.

The Basic version of the program has the ASTM Compliant Glazing Input.

The

Standard version also has the ASTM Complaint Glazing Input as well as the Advanced
Glazing Input. The Deluxe version contains all three input windows. The input

options are located in the Main Menu under Input, see Figure 3.1.

Window Glass Design 2004 --
File Input  Tools Window Help

v ASTM Compliant Glazing Irput
Advanced Glazing Input
Multiple Glazing Input

Dezign Standard

Figure 3.1 Changing Input Windows

3.1 ASTM Compliant Glazing Input

This is the program default window. When a new design is opened or the
Window Glass Design 2004 program is started the ASTM Compliant Glazing

Input window will open.

This input window provides all the space and information necessary to design
a glass unit to the specifications outlined in ASTM E 1300. The user chooses

a design standard, enters the glazing information, dimensions,

glass

construction and loading, Figure 3.2. Definitions and details about each input

can be found in Chapter 4: Terms and Definitions.

Window Glass Design 2004 o
Design Standard Glass Construction
]ASTM E1300-02/03 LJ Double Glazed Insulating Unit LJ Air Space; 05 i,
: : Outboard Lite Inboard Lite
Glazing Information e S
Edge Supparts: ]—_| S S
] Annealed - Annealed >
Glazing Angle; 90.0
[V Check for Laminated [ Check for Laminated
Rectangular Dimensions Ply Thickness: ¥R w| in Lite Thickness; 332 w| i
Wicth:
. ¢ 2| in:
’w in. Irterlayer Thickness: 0030
Pl Thickness: in;
Height: :
’w v Mominal Thickness: 316
Loads
Sketch
Short Duration [~ 3 sec ] 400  psf Long Duration [~ 30 days]: 400 psf
LCalculate

Figure 3.2 ASTM Compliant Glazing Input Window
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Selecting the Sketch |wi|| open a second window with a simple sketch of
the input glass dimensions, side support and glazing angle, Figure 3.3. The
hatching around the window indicates which sides are supported. This figure
represents a three sided support where the top, right and bottom sides have
hatch marks. This example also indicates the glass is at a 90 degree angle
from the horizon.

Lite Sketch [

| Check to Rotate Sketch S0°

iy ]
4,00 in.
90.0°
b A
3 4.00 in. A

Figure 3.3 Lite Sketch Window

Selecting the Lalculate | will run a system of checks to ensure all the
required information is input and compatible with the ASTM E 1300 design
standard. After completing this check, and finding no error, a Results window
will open displaying the Load(s) Input, the Load Resistance and the
Approximate Deflection as well as a short message of approval or disapproval
of the design, Figure 3.4.

Results - Single Glazed Lite (Laminated) E]
Short Duration Load, Resistance, and Deflection Data

Load [ & 3 zec.): 400  psf

Load Resistance: 1.1 psf

Approximate edge deflection under the applied Load: 018 in

Comments

- The non-factored load walues for laminated glass are representative of test data and calculations performed for an
interlayer at a terperature of 50 C [122 F)

Based onyour design information, the load resistance is greater than or equal o the specified
loading.

Details | Dane

Figure 3.4 Results Window
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Advanced Glazing Input

Available with the Standard edition of Window Glass Design 2004 is the
Advanced Glazing input. This window is very similar to the ASTM Compliant
input with several additions. To open an Advanced Glazing Input window,
click on Input in the Main Menu and select Advanced Glazing Input as shown
in figure 3.1 or click the plus button in the toolbar, Figure 3.5.

Window Glass Design 2004 --

File Input Tools Calculations Adigdow Help
> E e us s s ) il =

» — <
Window Glass Design 2004

Design Standard

Figure 3.5 Advanced Glazing Inpu't button location

The additions to the Advanced Glazing Input come from independent works
by Dr. Scott Norville and C.V. Girija Vallabhan. The first extension of the
basic input window is the Shape option. The advanced input also offers range
calculations, automatic thickness calculator and theoretical load share values.
Laminated nominal thickness values extend up to 1% inches. Details about
each of these input options is available in Chapter 4: Terms and Definitions.
Figure 3.6 provides a view of the Advanced Glazing Input window.

Window Glass Design 2004 [ =] <
Design Standard 1 [ Glazs Construction
|48TM E1300-02/02 -] | Double Glazed Insulating Unit ~|  pirspace |05 in.
: ; | [~ Outhoard Lite | [ Inboard Lite
i~ Glazing Information il
I Automatically Calculate Thickness I automatically Calculate Thickness
Shape; ’W Wiew
Glass Type: {Annealed - Glass Type: {Annealed =
Edge Supports: i P
¥ Check for Laminated I Check far Laminated
Glazing Angle: 900 °
Interlayer Type: PVE - Interlayer Type: .
Rectangular Dimensions | Fly Thickness: 13;4 ~| in Lite Thickness: 13;32 ~| in
Wickth:
0 in Interlayer Thickness: 000 -| in
Fly Thickness: 13;4 ~| in
Height:
0 in. Mominal Thickness: 1142 in

[ Loads

: | Sketeh
Shart Duration | ~ 3 sec.): 0 psf Long Duration | ~ 30 days): [ 0 psf r gﬁ:{l?zocrg[lgal Load —
Calculate

Figure 3.6 Advanced Glazing Input

The Sketch and Calculate buttons in the bottom right corner provide the same
information as the ASTM Compliant Input window, Chapter 3.1.
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3.3

Multiple Glazing Input

Available with the Deluxe edition of the Window Glass Design 2004 program is
the Multiple Glazing Input window. This window provides a quick solve
solution for multiple windows on a single structure design. To open the
Multiple Glazing Input window, click on Input on the Main Menu and select
Multiple Glazing Input, Figure 3.1.

Figure 3.7 shows the Multiple Glazing Input window. The Multiple Glazing
Input window provides a spreadsheet option with each row of the chart
representing a new glass unit, each column another value required to
calculate the lite’s load resistance.

" Multiple Glazing Input u@ﬁ

=

i~ Multiple Lites:

Yafidth Height “wind Load
[Unsupported) | [Supported)

Short Duration Results Frint
oa
Resistance

psf]

Snow Load
[30 day)

[psf)

Long Diuration
o3
Resistance
sl

Diezign

Angle Support Drescription Standard

ASTM E1300-

Glazing Edge ‘ Lite

[in.] fir.] [psf) [degrees]

Results

b ] 0 ] 0 50.0 4-Sided Define Lite N, N Erar N, v

Lite Manager Print

Figure 3.7 Multiple Glazing Input window

Column 1 is the Width or the Unsupported (if less than 4-sided supported)
dimension of the glass unit. The next column is the Height or Supported (if
less than 4-sided supported) dimension of the unit. The Wind Load column is
where the Short Duration (3 second) load is input. Next is the Long Duration
(30 day) or Snow Load data input. The Glazing Angle column defaults to 90
degrees or a vertical installation. This value can be altered for each lite input.
Edge Support is the last column for direct input in the Multiple Glazing Input
window. The user can choose from a list of 1, 2, 3 or 4 sided supports.

The lite description column also provides a dropdown list of each lite input or
an option to design a lite, Figure 3.8.

3 Lite Shar
ark Description 5

&
4 |Define Lite |

Figure 3.8 Lite Description List
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In Figure 3.8 the list displays “Define Lite” as well as several other options.
When first installed, the only option available is “Define Lite”. If this option is
selected, a new window will open, Figure 3.9, within which the user can define
the glass construction and design standard for the lite. Each defined lite may
be used repeatedly within the Multiple Glazing Input spreadsheet which
enables the user to design different supports, sizes and loading of the same
lite construction. This window may also be opened by clicking the
on the Multiple Glazing Input window.

Lite Construction
D esign Standard D escription
|ASTM E1300-02/03 ﬂ |ANN;’ANN
Glasz Construction AHTEHN
FT142
Double Glazed Insulating Unit ;l Air Space: 05 in HS7/8
Outboard Lite Inboard Lite
Glazs Tppe: Glazz Type:
Annealed - Annealed -

[~ Check for Laminated I Check for Laminated

Interlayer Type: J Interlayer Type:

Lite Thickness: ]1:’4 j in. Lite Thickness: 144 bl [

[ Use Theoretical Load Share Factors Mew Lite | ! | Done

Figure 3.9 Lite Construction Input window

Notice that the same lite descriptions are shown in the right hand list box as
were displayed on the Lite Description dropdown list in the Multiple Glazing
Input spreadsheet. This is the place where the user defines the glass
construction and design standard for each lite. Provided in this window is the
design standard options, single or double glazed construction, glass type, air
space, interlayer type and thicknesses. The user can add a new description of
a lite by clicking “New Lite” button or edit previously entered designs by
selecting the name of the description in the list provided at the right of the
window they wish to edit. If an insulating glass unit is being designed,
Theoretical Load Share values can be calculated by checking the box in the
bottom left corner. Clicking the Done will close this window and update
the Lite Description column to include the new design.

The final five columns display the results for the lite design. The Short and
Long Duration Load Resistance columns display the calculated resistance for
the design. “Error” or “NA” will display if the values cannot be calculated or
are not available. The Results column will display “OK” if the design load is
less than the calculated capacity. Design Standard column displays the
version of ASTM E 1300 used for the calculations and the final column allows
the user to check if they desire this lite to be included in the mass printout of
the Multiple Glazing Input results.

15



Terms and Definitions

4.1 Design Standard

4.2

Standards Design Group, Inc has had window design software since its
conception in 1998. The ASTM E 1300 standard that the software is derived
from has been edited and altered over the years and Window Glass Design
2004 provides the user the option of selecting which version of the standard
from which to base their glass design.

Located in the upper left corner of the ASTM Compliant and the Advanced
input windows is a drop down list containing all of the standards this program
is compatible with. By opening the list and selecting a version of ASTM E

1300 the design standard is set, Figu

re 4.1.

Window Glass Design 2004

Design Standard

|ASTM E1300-92/00

El

A5TH E1300-

94

ASTM E1300-38/00
ASTH E1:300-

02/03

Shape:

Glazing Information

4.2.1 Shape

|Heclangular LI
Figure 4.1 Design Standard selections

The Standard and Deluxe versions of Window Glass Design 2004 offer

the user the option of shape for the glass design.

Extensive research

conducted by Dr. Scott Norville allows Standards Design Group, Inc to
incorporate triangle, segmented circles, semicircles, circles, trapezoids,
parallelograms, pentagons, hexagons and polygons into our program.

Located on the left-hand side of the Advanced Glazing Input window,
just below the Design Standard is the drop down list of shape options,

Figure 4.2.

Window Glass Design 2004

D ezign Standard

Glazing I nformation

Shape:
Edge Supports:
Glazing Angle:

Fectangular Dimens
Wicith:

[ on

|ASTM E1300-02/03

Trapezoid

=

Bl

Riectangular
Triangular
Segment
Semicircle
Circular

Tr i
Parallelogram
Pentagon
Hexagon

Polygon

ew |

Figure 4.2 Shape selection list

16



4.2.2

Selecting the =1 next to the shape drop down list will open a new
window with a picture of the selected shape, Figure 4.3.

Lite Shape - Trapezoid

Ve

6
—— wbieq——] 5

—— Width ——

Figure 4.3 Lite Shape window example

Edge Supports

In the 2002 revision of the ASTM E 1300 standard 1, 2 and 3 sided
supports were introduced. Located on the left hand side of the ASTM
Compliant or Advanced Glazing Input windows (Column 6 of the Multiple
Glazing Input, Figure 3.7) is a drop down list of available edge support
options. If the user selects an earlier version of the ASTM E 1300
standard they will notice that this list is ‘locked’ to 4-sided support. The
edge support will also lock if a Double Glazed Insulating Unit is chosen
for the glass construction. An example of a locked and unlocked Edge
Support drop down list is shown is Figure 4.4.

Window Glass Design 2004 Window Glass Design 2004
Design Standard Design Standard
[A5TM E130002/03 -l |AsTM E1300:88/00 |
Glazing Information Glazing Information
EdgeSupports: |4 5ides Edoe Supportss  [1o0- o
. 1 Side o
Glazing Angle: 2 Sides Glazing Angle: 90.0
3 Sides
: 4 Sides i
Rectangular Dimerys Rectangular Dimensions

Figure 4.4 Unlocked (left) and Locked (right) Edge Support list
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4.2.3

Glazing Angle

Located below the Edge Support option is the Glazing Angle, Figure 4.5
(Column 5 in the Multiple Glazing Input window, Figure 3.7). The
Glazing Angle indicates the installation position of the glass unit. The
program will default to 90 degrees or a vertical lite installation. If the
user alters the angle of the lite, Window Glass Design 2004 will
automatically add the glass self weight to the short and long duration
load inputs. If no loads have been input, self weight will still be
considered. Selecting the sketch  |Will display the current glass input
angle shown previously in Figure 3.3.

Window Glass Design 2004

Design Standard
|ASTM E1300-02/03 |

Glazing Information
Edge Suppoits: 4 Sides -

Glazing Angle: 45.0

Figure 4.5 Glazing Angle Input location

4.3 Rectangular Dimensions

Basic dimension input requires a width and a height of the glass unit. These
inputs are located on the left of the input window, Figure 4.6 (Columns 1 and
2 of the Multiple Glazing Input window, Figure 3.7)

Rectangular Dimensions

vicith:

4.00 in.

Height:

4.00 in.

Figure 4.6 Rectangular Dimensions
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If the user selects a non-rectangular lite shape, the dimension requirements
will change accordingly. Figure 4.7 shows an example circular lite shape
selected and the Rectangular Dimensions now require a diameter.

4.3.1

Glazing Information

Shape: Circular - Wiew
Edage Supports:
Glazing Angle: 450 °

Rectangular Dimensions
Diameter:

400 in.

Figure 4.7 Example dimension input for non-rectangular shape

Range Values

Available in the Standard and Deluxe versions of the software are Range
Value calculations. This addition allows the user to define a lite and
calculate the load resistance for a specific width and varying heights or a
specific height with varying widths. The user may also vary the height
and width. To use the Range Values option, click the button in the tool
bar that applies to the dimension desired, Figure 4.8. From left to right
the buttons represent: Range Width, Range Height and Both.

Window Glass Design 2004 [ Design4.gla ]

File Input Tools Caloulations Window Hel
T RS us st | 4 bk )
P

Window Glass Design 2004

Design Standard Glz

[46TM F1aNNM2NA vl [&i
Figure 4.8 Range calculation buttons

When selected, the Rectangular Dimension section of the window will
open new input boxes for the minimum, maximum and interval of the
selected range dimension. Figure 4.9 shows the display for a Range
Height selection. Example: a 2-sided edge support lite with a width of
24 inches and a range height of 24 to 36 inches at 4 inch intervals is
input, Figure 4.9. The Results screen, Figure 4.10, displays the input
information as well as the Load Resistance and “Ok” or “Not OK” Results.
The Supported or Width column shows 24 inches and the Unsupported
or Height column displays 24, 28, 32 and 36 inches or the heights
specified in the input window. Each row displays the results of each
pairing.
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Window Glass Design 2004

Design Standard

|.&STM E1300.02/02

Glazing Infarmation

Rectangular Dimenzions
Unsupported Length:

[~ |

Shape: IHectenguIer vl Wiew I
Edge Suppoarts: |2 Sides vI
Glazing Angle: | 00 “

[ 240 in,

Supported Length:

[ 20n | 30 in | 400 in
Iiirnirn o asimum Iriteryval

Figure 4.9 Range Height input example

[
Results - Single Glazed Lite (Monolithic) M=
Supported Unsupported | Short Duration Short Duration Short Durstion Resufts
Length Length Load Load Load
Resistance Deflection
(in.J (in.) (=25 (=25 (in.J
» 240 240 100 383 0.03 0034
240 280 100 383 003 (o34
240 320 100 353 003 K
240 360 100 383 0.03 (034

Figure 4.10 Range Height output example

The Range Values option is similar to the Multiple Glazing input in that it
can calculate multiple inputs and display them in one results window.
The difference between the two is that Range Values are limited to one

glass construction, angle and support structure.

The Multiple Glazing

Input allows the user to change those all input values.
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4.4

Glass Construction

Two options are available for the Glass Construction, Single Glazed Lite and
Double Glazed or an Insulating Glass (IG) unit. Selection the glass
construction is located in the center of the ASTM Compliant or Advanced input
windows, Figure 4.11. For the Multiple Glazing Input, this selection is within
the Lite Manager window and located at the left side of the window. If a
Double Glazed unit is selected an Air Space input box will be displayed to the
right of the glass construction drop down list. The Air Space represents the
distance between the two lites of the IG unit.

Window Glass Design 2004

Design Standard Glass Construction
|ASTM E1300-98/00 | |Dauble Glazed Insulating Unit x| 4 Space: 0.5 in.
Glazing I i Outboard Lite Inboard Lite

Figure 4.11 Glass construction selection and air space location

4.4.1 Automatic Thickness Calculator

In the Standard and Deluxe versions of Window Glass Design 2004 is a
tool that when checked will calculate the smallest possible thickness for
the user input dimensions and load requirements. Located just above
the Glass Type input is a check box labeled “Automatically Calculate
Thickness”, Figure 4.12. When selected the thickness inputs will be
removed. This option does not work when the Range Values option is
selected.

Glass Construction

|Double Glazed Insulating Unit j Air Space; IF in.
Outbozrd Lik
< Iv Automatically Caleulate Thickness > < [ Automatically Calculate Thickness >
Glass Type: | Annealed Glass Type: | &rnealed
[¥ Check for Laminated I Check for Laminated

Interlayer Type: Irterlayer Type: |
Figure 4.12 Automatic thickness calculator location
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4.4.2

4.4.3

4.4.4

Glass Type

The glass types provided in this program are Annealed, Heat
Strengthened and Fully Tempered. These are the same types used in
ASTM E 1300. The glass type can be changed by selecting the desired
type from the drop down list, Figure 4.13.

Glazz Construction
|D0uble Glazed Insulating Unit j Air Space: 0s in.

Outboard Lite Inboard Lite
V' _ALLacaskeieSum

I Automatically Calculate Thickness

Glass Type: Annealed Glass Type: Annealed _ﬂ
[ Chedr o esmme I Check for Laminated
Interlayer Type: Interlayer Type: |

Figure 4.13 Glass type location

Laminated Check

Each lite in the glass unit may be designed as laminated or monolithic.
To design a laminated unit select the box next to “Check for Laminated”,
Figure 4.14.

Glazz Construction

|D0uble Glazed Insulating Unit j Air Space: [T in.
Outboard Lite Inboard Lite
v Automatically Calculate Thickness I Automatically Calculate Thickness
Glass Type: Annealed - Glasz Type: ’m
[¥ Check for Laminated I Check for Laminated
Interayer Type: [ | Interayer Type ErE

Figure 4.14 Laminated glass check location

Interlayer Type

ASTM E 1300 provides information for laminated glass with the PVB
interlayer. This is the only interlayer available for the Basic version of
the software and the ASTM Complaint Input. In the Advanced Glazing
Input window and the Lite Manager window of the Multiple Glazing Input
there are two additional interlayers available. The Standard and Deluxe
editions of the program now includes the Saflex® HP and the
SentryGlass® Plus interlayers. Standards Design Group, inc. has
worked closely with Solutia and Dupont to include their interlayers. The
program also includes the non-factored load charts for these interlayers
which are displayed in the “Details” option of the results.

The Interlayer Type list is located below the “Check for Laminated”
option on the Advanced Glazing Input window, Figure 4.15. PVB is the
default interlayer for the ASTM Compliant Input and the Interlayer Type
list is not displayed in this input window.

22



4.4.5

Glazz Construction

| Single Glazed Lite =
Single Lite
[~ Automatically Calculate Thickness
Glass Type: |An'nea|'ed ;|
v C

Interlaper Type: B e
) PvB
Ply Thickness: SentyGlas® Plus

Saflex® HP
Interlaver Thickness: 0030
Figure 4.15 Interlayer type list location for Advanced Glazing Input

Thickness

The Lite Thickness input is located at the bottom of the Glass
Construction section, Figure 4.16. This is where the thickness of each
layer of glass is input. If designing a monolithic lite, only one thickness
will become available. Laminate designs provide two thicknesses. For
versions of ASTM E 1300 earlier than 2002 and/or double glazed, IG
glass units the plies of the laminated glass will be equal and locked.
Only Single Glazed units designed with the 2002/04 standard may have
asymmetric, laminated design. The software will lock and unlock this
option as necessary. By default the program will initially select a
symmetric ply thickness for a laminate design and the user may alter
the second ply thickness as desired. The Nominal Thickness is
representative and does not necessarily include the interlayer thickness.

Glass Construction Glass Construction

| Single Glazed Lite | | Single Glazed Lite |
Single Lite Single Lite
™ Automatically Calculate Thickness I Automatically Calculate Thickness
Glass Type: ’WI Glass Type: IW[
IW Check for Laminated [ Check for Laminated
Interlayer Type: Interlayer Type:

Ply Thickness:

Lite Thickness: I GTal 5) Iln

Interlayer Thickness:
Fly Thickness:

tominal Thickness:

Figure 4.16 Laminated (left) and monolithic (right) thickness input

23



4.5

Loads

The final input for design is the required loading. The loads are input at the
bottom of the ASTM Compliant or Advanced Glazing Input windows, Figure
4.17 (Columns 3 and 4 of the Multiple Glazing Input window).

4.5.1

4.5.2

4.5.3

Loads
Sheort Duration [~ 3 zec. | 0 psf Long Duration [ ~ 30 dayz]: 0 psf

Figure 4.17 Load input location

Short Duration Load

A short duration load is defined by ASTM E 1300 2002/04 as any load
lasting 3 seconds or less. Earlier editions of the standard define a short
duration load as 60 seconds or less. (To change between a 60 second
and 3 second load, refer to Section 2.8 Load Converter) Most short
duration loads are wind loads using a 3 second, 50 year design wind
speed which is why the standard’s definition of a short duration load was
changed from 2002 on.

Long Duration Load

A long duration load is defined as a load lasting approximately 30 days.
This loading type usually covers snow loads and self weight. Self weight
is automatically input by the program if the glass unit is not at a 90
degree installation angle. A load can be changed to a long duration or
short duration by using the Load Converter (Refer to Section 2.8).

Theoretical Load Share Factors

ASTM E 1300 explains that Double Glazed, IG units “share” the load
placed upon them. A simplified explanation as the load is placed upon
the first lite this lite deflects and pushes the air space into the second
lite thus pushing the load or sharing the load with the second lite.
Window Glass Design 2004 uses the method defined by ASTM E 1300 to
calculate this Load Share Factor. With the Advanced Glazing Input
window a second option is available to the user. A check box labeled
“Use Theoretical Load Share Factors” is made available when in the
Advanced Glazing Input window and if a Double Glazed, IG Unit is
selected, Figure 4.18. This feature finds it basis in the publication "The
Structural-Mechanics Behavior of Insulating Glass Units" by C. David
Chou, Joseph E. Minor, and C.V. Girija Vallabhan. When selected, Load
Share Values are calculated using the work of C.V. Vallabhan instead of
the ASTM E 1300 standard.

Loads

Short Duration [~ 3 sec.): 0 psf Long Duration [~ 30 daps): [ o psf r gﬁ:[;?z%ﬁt::al Load

Figure 4.18 Theoretical load share factor option
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Results
Main Results Window

After all the necessary information is input and the  Calculate |is selected then
a new window will open with the resulting information and calculations. There
are several different Results windows. All of them contain the same
information in different forms. The Multiple Glazing Input window displays
the results in the same spreadsheet as the input values. A typical results
window may be seen in Figure 5.1. The output will differ depending on the
input. If Range Values are input then the Results window will resemble a
spreadsheet with each output value in a separate column. These output
values are explained below.

Results - Single Glazed Lite {Monolithic) ™=l <

Shart Duration Load, Resistance, and Deflection Data

Load [ = 3 sec.): 100 psf
Load Resistance: 100 psf
Approximate center of glass deflection under the applied Load: 1.74 in

Long Duration Load, Resistance, and Deflection Data

Load [ = 30 days): 200 psf
Load Resistance: 501 psf
Approzimate center of glass deflection under the applied Load: 085 in
Comments

Based onyour design information. the load resistance is greater than or equal fo the specified
loading.

Dretailz | Dane

Figure 5.1 Typical results window

5.1.1 Load

This value is the actual load entered by the user on the input window. If
both a Short Duration Load and Long Duration Load were entered, both
should be displayed in separate sections on the Results window. The
user defined required loads will be the first item displayed.

5.1.2 Load Resistance

The user input dimensions and thickness are used with a Non-Factored
Load chart to select a “Non-Factored Load”. This load is then multiplied
by a Load Factor which may increase the value depending on the load
duration and glass type. This is the maximum allowable load for the
glass unit design. The Non-Factored Load chart is provided as part of
the final detailed report printout as well as in the details option, Section
5.2.
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52

51.3

51.4

Approximate Deflection

A second chart is used that allows the user to locate the approximate
deflection. This chart requires the user input load and dimension
information. The Approximate Deflection is in the center for 4-sided and
2-sided supports and on the edge of glass for 3-sided and 1-sided
supports.

Comments

The final section of the Results window are the comments. In the
Multiple Glazing Input and Range Value results windows these comments
are an “OK” or “Not OK” as a pass/fail display of the required load on
the input glass design. On the basic Results window these comments
include a green display for “pass” and red display for “fail” of the unit
design. If the load required of the glass design exceeds the calculated
factored load then the lite is unacceptable according to ASTM E 1300.

Probability of Breakage: A numerical “safety factor” is not provided for
glass design. Instead a “Probability of Breakage” is given. This is the
possibility of how many units out of 1000 with this design and load
condition will break.

Details Report

Selecting the Dl will open a second results window displaying the
values used to calculate the Load Resistance displayed on the first Results
window, Figure 5.2.

Details g L
Single Lite
1~ Short Duration Losc
Mon-Factored Load: B0 psf
Glass Type Factor: 1.00
Load Resistance: B0 psf
Approximate D eflection: 016 in
1 Long Duration Load
Mon-Factored Load: EOT  psf
Glazs Type Factor: 0.5
Load Resistance: 300 psf
Approximate D eflection: 002 in
Mon-Factored Load Chart

Figure 5.2 Details Window
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52.1

52.2

523

524

Non-Factored Load

The Non-Factored Load is found using charts provided by ASTM E 1300.
The charts require dimension and thickness information and using this
information a Non-Factored load is found. The first value in the Details
Window is the load from the chart.

Glass Type Factor

The second value displayed on the Details window is the Glass Type
Factor. This factor, provided in Tables 1 and 2 of the ASTM E 1300
standard, are multipliers for the Non Factored Load. The Glass Type
Factor is selected based on the load duration, glass construction and
glass type. A long duration, IG unit constructed of monolithic fully
tempered glass has a Glass Type Factor of 2.85 for both lites where as a
short duration load, single glazed, annealed glass unit has a Glass Type
Factor of 1.

Load Resistance
Multiplying the Glass Type Factor with the Non-Factored load will
produce the Load Resistance of the glass unit. The Load Resistance is
the third line displayed in the Details Window and is also shown in the
Results window.

Approximate Deflection

This value is the same as displayed in the Results window, Section
5.1.3.
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53

Non-Factored Load Chart

Mon-Factored Load Chart

Selecting the will open a third results window.
The Non-Factored Load chart is taken from the ASTM E 1300 standard and is
what is used to find the Non-Factored Load, Figure 5.3. Red lines mark the
dimensions used to locate the Non-Factored Load. Interpolation is used when
the lines cross between two loads.

—

8.0 mm (5/16 in.) - (4-Sided Simply Supported) Ed|
Plate Length {in)
0 50 100 150 200
140 FE.0mm (5M 6 in.) Glass n7s,
Honfactored Load (kPa) LN
Four Sides Simply Supported i
120 | » o
125 Ty oy
\ _—
= A0 150 b Y Yl W’ £
= N Y » £
g = 2m 2, 2000 %
= 28 - = =
2 w s AN A =
o ‘ ' P =
so0 N o
ar 700 ~ 000
oo
el
o ' 0
0 1000 2000 3000 4000 5000
Plate Length (rm) -m

Figure 5.3 Non-Factored load chart

This chart may be printed by selecting from the Main Menu File > Print > Print
Details Report.
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Appendix A: ASTM Compliant Glazing Design Example

Glass Input
Dimension: 60 inch x 48 inch, ¥4 inch thickness
Glass Type: Single Glazed, Heat Strengthened, 4-sided support
Load Requirement: Wind Load of 26 psf
Design Standard: ASTM E 1300 - 2004

Input

The default design standard is “ASTM E 1300-2002/03”
(Note: no calculation changes have occurred between the 2002 and 2004)

The default edge support is 4-sided.
The default glazing angle is 90 degrees.

Dezign Standard
|ASTM E1300-02/03 |

Glazing Information

Edge Supports: 4 Sides -

a
Glazing Angle: 0.0

In the Width box, enter 60
In the Height box, enter 48

Rectangular Dimenzsions
Wyidth:

E0.0 in.

Height:

43.0 in.

In the Glass Construction Single Glazed Lite is a default
Select Glass Type “Heat Strengthened”

Single Lite
[alazz Tope:

| Heat Strengthened j

Annealed
Heat Strengthened

Full$ TEW:EE[.EEI | Iﬂi_

—

—

Al-1



Select “1/4” from the lite thickness list

Single Lite
Glazs Type:
|.t’-‘n.nnea|ed j

[ Check for Laminated

Lite Thickness: 144 - | in
3432 ”~
Larni
148
B/32
3416
144
A6
38 hal

Enter “26” in the Short Duration (—3 sec)

Loads
Shart Duration [~ 3 sec.): 26.0  psf Long Diuration [~ 30 daps): 0 psf
. Sketch

Click =

Displayed is a window with a rectangular lite with the given dimensions of 48
inches and 60 inches. The hatching represents support and this figure shows
all sides with the hatching which is consistent with the 4-sided support
selected. The right side of the picture represents the side view of the glass
unit. This unit is at a 90 degree angle or completely vertical.

Lite Sketch (=)

v ct

48.0 in.

30.0°

6.0 in.

Al -2



Results

. . Calculate
Close the sketch window and click =
Results - Single Glazed Lite (Monolithic) ™ =]
Shart Diwration Load, Fesistance, and Deflection D ata
Load [ % 3 sec] 260 psf
Load Resistance: 103 psf
Approzimate center of glazs deflection under the applied Load: 04 in

Comments

Based onyour design information, the load resistance is greater than or equal to the specified
loading.

Details | Dane

Load (—3 sec) is the actual load we input or “26” pounds per square foot.

The Load Resistance is the calculated maximum amount the glass design can
handle, in this case “103 psf”

The Approximate center of glass deflection under the applied (or 26 psf) load
is 0.4 inches. Because the light is symmetrically supported (4-sided), the
maximum deflection is in the center of the glass.

Because the load we desire to apply to our glass design (26 psf) is less than
the calculated load capacity (103 psf) our design passes as indicated with the
green, bold font.

Dane

Clicking | will close the Results window
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Click Details |

Details g mil| x|
-Single Lite
[ Short Durstion Load
MHon-Factared Load: 515 paf
Glazz Type Factor: 2.00
Load Resistance: 103 psf
Approzimate Deflection: 04 in
Maon-Factored Load Chart

The Non-Factored Load is the value pulled from the Non-Factored Load Chart
(Explained below) for the dimensions we entered.

The Glass Type Factor is the multiplier for the Non-Factored Load. Because
we chose “Heat Strengthen” glass, the Glass Type Factor is “2.00".

The Load Resistance is the Glass Type Factor multiplied with the Non-Factored
Load. (51.5* 2 = 103)

The Approximate deflection is also displayed in this window.
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C I iC k Mon-Factored Load Chart

6.0 mm (1/4 in.) - (4-Sided Simply Supported)
Flate Length {in.}
o 50 100 150 200
= K P
190 FB.Omm (144 in) Glags 05 L
Honfactored Load §Pa) . 1
Four Sides Sim ply Supported My
120 | ]
ors — . 2000
100 - o el =
E 1.m M E
£ 1z L =
T A 150 )(‘ :.:’ o - 2000 =
] =
% 20 = P s =
s 9F 25 A . L~ -1 L] =
T 7 T} - i
af cihi - 1000
7.0
i00
23 L
[
5 ] [ TR T LT TTTTU o
o 1000 20 3000 4000 5000
Flate Length {mm)

To find the Non-Factored load, each thickness has a separate chart within
ASTM E 1300. In the top, left hand corner you will notice “6.0mm (1/4 in)”
written. This is the thickness we selected in the input screen. Since we
desire to use US units, our dimensions will be in inches. Dimensions in inches
are located on the left side and top of the chart. Red lines are provided for 48
inch height and 60 inch width. Where the two dimension meet are just above
the “2.50” kilopascal line. Using interpolation we can assume the Non-
Factored load of 2.45 kPa which equals 51.169 psf which is close to what the
program displays. (The software has the ability to be more accurate with the
interpolation)

Report

Sample Reports of this example are on the following pages.
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Glass Load Resistance Report --

Glazing Information Project Details
Edge Supports: 4 Sides Project Name:
Glazing Angle: 90° Location:

Lite Dimensions: Comments.
Width: 60.0 in.
Height: 48.0 in.

Glass Construction (Rectangular)

Single Glazed Lite { Heat Strengthened }
Nominal Thickness: 1/4 in.

Short Load Duration. Resistance, and Deflection Data

Load (~ 3 sec.): 26.0 psf

Load Resistance: 103 psf

Approximate center of glass deflection: 0.4in.
Conclusion

Based on your design information, the load resistance is greater than or equal to
the specified loading.

Statement of Compliance

Procedures followed in determining the resistance of this window glass are in accordance with ASTM E1300-02/03.

Disclaimer:
This software can be used to determine the load resistance of specified glass types exposed to uniform lateral loads of short or long duration subject to the following conditions:
- The glass is free of edge and surface damage and has been properly glazed in the opening in conformance with the manufacturer's recommendations.
- Procedures exist to determine load resistance for rectangular glass assemblies that are:
a. Continuously supported along all four edges,
b. Continuously supported along three edges,
c. Continuously supported along two parallel edges, and
d. Continuously supported along one edge.
- The software user has the responsibility of selecting the correct procedures for the required application from the software.
- The stifiness of members supporting any glass edge shall be sufficient that under design load, edge deflections shali not exceed L/175,
where L denotes that length of the supported edge.

For other limiting conditions that may apply, refer to Section 5 of ASTM E1300 and local building codes.

Neither SDG nor PGMC guarantees and each disclaims any responsibility for any particular results relating to the use of the Window Glass Design 2004 Software Program.
SDG and PGMC disclaim any liability for any personal injury or any loss or damage of any kind, including all indirect, special, or consequential damages and lost profits,
arising out of or relating to the use of the Window Glass Design 2004 Software Program.

Prepared by: on 3/22/2006

Window Glass Design 2004 - Version [1.6] Copyright © 2002 SDG, Inc. Page 1 of 1



Details Report --

Wednesday, March 22, 20

Lite Sketch
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Calculation Details

Single Lite
Short Duration Load
Non-Factored Load:
Glass Type Factor:

Load Resistance:

51.5 psf
2.00

103 psf

Approximate Deflection:

04in.

Window Glass Design 2004 - Version [1.6] Copyright © 2002 SDG, Inc.

Page 1 of 2



Details Report - Wednesday, March 22, 20

Single Glazed Lite: 6.0 mm (1/4 in.) - (4-Sided Simply Supported)

Plate Length (in.}

0 50 , 100 150 200
7 Y ———— T T 7
190 £ 6.0mm (14 in.) Glags ns L
r Nonfactored Load kPa)
I Four Sides Sim ply Supported
120 | p. o]
3 s — - 3000
- y .
~ 10 1m d *i €
E | ' €
~ L 1.25 -4 ~
5 of 150 £ —>] 2000 =
s : zan>: IS
® &0 250 > ™| <
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@t s 1000
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Plate Length {mm}

Window Glass Design 2004 - Version [1.6] Copyright © 2002 SDG, Inc. Page 2 of 2



Appendix A: Advanced Glazing Design Example

Glass Input
Dimension: 36 inches supported, range unsupported height from 36-60
inches, 1/4 inch thickness
Installation: 45 degree angle
Glass Type: Single Glazed, Laminated, Fully Tempered, 2-sided support
Load Requirement: Wind Load of 30 psf
Design Standard: ASTM E 1300 - 2004

Input

The default design standard is “ASTM E 1300-2002/03”
(Note: no calculation changes have occurred between the 2002 and 2004)

The change the edge support to 2-sided
The change the glazing angle to 45 degrees

Dezign Standard
ASTHM E1300-02/03 j

Glazing Infarmation

Shape: Rectangular = Wiew
Edge Supparts: 2 Sides ~
Glazing Angle: 45 °

Select the )|H|+ from the tool bar

Enter a minimum unsupported length of 36 inches
Enter a maximum unsupported length of 60 inches
Enter an unsupported length interval of 4 inches

Enter a supported length of 36 inches

Rectangular Dimensions

Unsupported Length:

| 30 in. | EOD in | 400 in
b M aximum Interval
Suppored Length:

| 360 in

A2 -1



In the Glass Construction list, Single Glazed Lite is the default
Select a Glass Type of “Fully Tempered”

Single Lite
[ Automatically Calculate Thickness
Glazs Type: Fully Tempered ﬂ
Annealed
M ol e L Heat Strengthened
~ [Fully Tempered I
Interlayer Type: I —

Check the “Check for Laminated” box

Glass Type: Fully Termpered ﬂ
v Check far Laminated

(ond o TP lwom

“PVB” is the default interlayer
Select “1/8” for the ply thickness.
Notice the second ply thickness automatically selects “1/8” as well.

Interlayer Type: |pv|3 ﬂ Interlayer Type: |WB ﬂ

Ply Thickness: 1/8 -| i Fly Thickness: 1/8 - in
ETE] _ .

Interlayer Thickness: Lami If. Interayer Thickness: 00 - N
148

Ply Thickness: gﬁg in. Ply Thickness: 148 =] in

. ) 144 . : ) .

Hominal Thickness: 5ME if. Mominal Thicknezs: 144 In.

38

Enter a Short Duration Load of 30 psf

Loads

Shaort Duration [~ 3 sec.]: 0.0 psf Long Duration [~ 30 days]: 0 psf

A2 -2



Click ___=2ksteh

Displayed is a window with a rectangular lite with the given dimensions of 36
inches and 36 inches. The window does not display every possible
unsupported height. The hatching represents support and this figure shows
two parallel sides with the hatching which is consistent with the 2-sided
support selected. The right side of the picture represents the side view of
the glass unit. This unit is at a 45 degree angle.

Lite Sketch =

™ Check to Rotate Sketch 90°

(The “Check to Rotate Sketch 90 degrees” will rotate the left sketch to show
the supported edges on the sides instead of the top and bottom.)

A2 -3



Results

. . Calculate
Close the sketch window and click - =
Results - Single Glazed Lite (Laminated) E] ] [
[ Unsupported Supported Short Durstion Short Duration Short Duration Long Durstion Liong Durstion Long Duration Results
Lencth Lencth Load Loacd Lioacd Loz Load Approximate
Resistance Deflection Resistance Deflection
(in.) (in.) (pzf) (pzf) (in.) (pzf) (psf) (in.)
» | 6.0 36.0 32.2 47.9 1140 220 35.9 0.05 QK
40.0 36.0 322 3584 168 220 288 011 Qe
44.0 36.0 32.2 3.4 =147 220 239 017 MOT Ok
458.0 36.0 32.2 2649 Az 220 202 0.24 MOT Ok
520 36.0 322 3.0 =187 220 17.2 0.33 MOT Ok
S6.0 360 322 1938 =197 220 1449 0.44 MOT Ok,
50.0 36.0 32.2 17.3 =187 220 13.0 0.55 MOT Ok

The first column, the Unsupported Length, displays our range values, 36
inches to 60 inches at 4 inches at a time. The second column, the Supported
Length, displays the 36 inch, set value. The Short Duration load is not the 30
psf that was entered on the input screen. This is the 30 psf load as well as
the unit’'s own weight. Notice also that the Short Duration Load Resistance
values decrease as the unsupported length increases. The deflection under
the short duration load also increases as the unsupported length increases.

You will also notice that though no Long Duration Load was entered a value is
displayed. This is also a self weight value. Because the lite is at a 45 degree
angle, self weight is added to both loading cases. As with the short duration
load output, the Long Duration Load Resistance decreases and the deflection
increases as the unsupported length increases.

The final column is the pass/fail value for the design and load requirements.
In our example the Short Duration Load requirement is the controlling factor.

The load of 32.2 psf exceeds the load resistance of 31.9 psf. The lite passes
as long as the unsupported length is less than 40 inches.

Report

Sample Reports of this example are on the following pages.
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Glass Load Resistance Report -- Thursday, March 23, 20C

Glazing Information
Edge Support: 2 Sides
Glazing Angle: 45°
Lite Dimensions:

Minimum Unsupported Length:  36.0 in. Supported Length: 36.0in.
Maximum Unsupported Length:  60.0 in.
Unsupported Length Interval: 4.00in.

Glass Construction(Rectangular)

Single Glazed Lite { Fully Tempered }
Interlayer Type: PVB
Outboard Ply Thickness: 1/8 in.
interlayer Thickness: 0.03in.
Inboard Ply Thickness: 1/8 in.

Nominal Lite Thickness: 1/4 in.

Load, Resistance, and Deflection Data

Short Duration Long Duration

Width | Height | Load [ Load Approximate | Load | Load Approximate | Results
Resistance | Deflection Resistance | Deflection

(in.) j(in) |(psf) | (psf) (in.) (psf) | (psf) (in.)
36.0 36.0 32.2 47.9 1.10 2.20 35.9 0.08 OK
40.0 36.0 32.2 38.4 1.68 2.20 28.8 0.11 OK
44.0 36.0 32.2 31.9 >1.97 2.20 23.9 0.17 NOT OK
48.0 36.0 32.2 26.9 >1.97 2.20 20.2 0.24 NOT OK
52.0 36.0 32.2 23.0 >1.97 2.20 17.2 0.33 NOT OK
56.0 36.0 32.2 19.8 >1.97 2.20 14.9 0.44 NOT OK
60.0 36.0 32.2 17.3 >1.97 2.20 13.0 0.58 NOT OK

Window Glass Design 2004 - Version [1.8] Copyright © 2002 SDG, Inc. Page 1 of 2



Glass Load Resistance Report -- Thursday, March 23, 20C

Statement of Compliance

Procedures followed in determining the resistance of this window glass are in accordance with ASTM E1 300-02/03.

Disclaimer:
This software can be used to determine the load resistance of specified giass types exposed to uniform lateral loads of short or long duration subject to the following conditions:
- The glass is free of edge and surface damage and has been properly glazed in the opening in conformance with the manufacturers recommendations.
- Procedures exist to determine load resistance for rectangular glass assemblies that are:
a. Continuously supported along all four edges,
b. Continuously supported along three edges,
¢. Continuously supported along two parallel edges, and
d. Continuously supported along one edge.
- The software user has the responsibility of selecting the correct procedures for the required application from the software.
- The stiffness of members supporting any glass edge shall be sufficient that under design load, edge deflections shall not exceed L1175,
where L denotes that length of the supported edge.
- The non-factored load values for laminated glass are representative of test data and calculations performed for an interlayer at a temperature of 50° C (122° F).
For other limiting conditions that may apply, refer to Section 5 of ASTM E1300 and local building codes.

Neither SDG nor PGMC guarantees and each disclaims any responsibility for any particular results relating to the use of the Window Gtass Design 2004 Software Program.
SDG and PGMC disclaim any liability for any personal injury or any loss or damage of any kind, including all indirect, special, or consequential damages and lost profits,
arising out of or relating to the use of the Window Giass Design 2004 Software Program.

Prepared by: on 3/23/2006
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Appendix A: Multiple Glazing Design Example

Glass Requirements

Input

Dimension: 96 inch x 48 inch, ¥z inch thickness

Glass Type: Single Glazed, Annealed, Laminated, Store Front Window
(Three panes of glass, butt glazing between panes, continuously
supported around total unit)

Load Requirement: Wind Load of 17 psf

Design Standard: ASTM E 1300 - 2004

Butt glazing suggests the glass supports each other and is not covered within
this program. However a conservative estimate could involve the end panes
as three sided support and the center pane as a two sided support and ignore
the butt glazing for the time being. Instead of running two separate input
windows and taking the time to enter the information twice, the Multiple
Glazing input may be used.

Click Lite Manager

Enter a Single Glazed Unit
Fully Tempered Glass type
Check for Laminated with ply thicknesses of ¥4 inches each.

The example is labeled as “FT Lami ¥2” to signify Fully Tempered, Laminate,
% inch nominal thickness.

Lite Construction

Design Standard Deszcription

|asTME13000203 v [FT Lami1/2

Glass Construction

FT Lami 1/2

|Single Glazed Lite |

Single Lite
Glazz Type:
]Fully Tempered ﬂ

IV cCheck for Laminated

Interlayer Type: PvB i
Fly Thickness: 144 x| in
Interayer Thickness: m in.
Ply Thickness: 1/4 Xl i
Marminal Thickness: 142 in.

Mew Lite | T | Done
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Click \y

From left to right enter: “96”, “48”, “23”, “0”, “90”, “3-sided” and “FT Lami
14" to represent the sides of the store front window.

G Clana Tnoat M=

7 Multiple Lites i
“width .H;aight ‘witd Load | Show Load GI:azing Edge Lit.e Short Duration | Long Duration | Results Design F‘riﬁt
[Unsupported] | [Supported) [30 day) Angle Suppart Description Load Load Standard Results
Resistance Resistance
fin.] [in.] [p=f] [p=f] [degrees) [psf] [psf] ASTH E1300-
96.0 430 230 i 90.0 3-Sided FT Lami 1/2 > 835 (AT 0K 0z/03 v
> o o 0 0 90.0 4-Sided Define Lite M (FES Ermar Mt v

Lite Manager Prirt

You will notice that the program fills the final 5 columns with the results and
because the required load is less than the Load Resistance this design passes.

To complete the calculation, enter from left to right: “96”, “48”, “23”, “0”,
“90”, “2-sided” and “FT Lami ¥2”

T Muttipla Clazing Tnpat BEx)

7 Multiple Lites 1
“wiidth Height “wind Load | Snow Load | Glazing Edge Lite: Short Duration| Long Duration | Results Dezign Frint
[Unsupported] | [Supported) [30 day] Angle Support Diescription Load Load Standard Results
| Resistance Resistance
fin.] fir.] [psf] [pef) [dedrees]| [psf] [pzf) ASTH E1300-
9E.0 43.0 23.0 0 90.0 3-Sided FT Lami1/2 > 835 M8 oK 02/03 Ird
> 36.0 450 230 0 30.0 2-Sided FT Lami1/2 30 A2 akK 02/03 v

Lite Manager | Prirt |

Even though the load resistance is smaller than the 3-sided support, the 2-
sided edge supported center panel passes the load requirement of 23 psf.
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A new window will inquire if you would like separate reports of each lite
and/or the Multiple Input spreadsheet. Check or uncheck the desired reports.

Print Window

[+ tultiple Lite Input 5preadsheet
[+ tultiple Lite Input Reports

Cancel | Prirt |

Report

Sample Reports of this example are on the following pages.
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Glass Load Resistance Report --

Glazing Information Project Details
Edge Supports: 3 Sides Project Name:
Glazing Angle: 90° Location:

Lite Dimensions: Comments:

Unsupported Length: 96.0 in.
Supported Length:  48.0 in.

Glass Construction (Rectangular)

Single Glazed Lite { Fully Tempered }

Interlayer Type: PVB
Outboard Ply Thickness: 1/4 in.

interlayer Thickness: 0.03 in.
Inboard Ply Thickness: 1/4 in.
Nominal Thickness: 12 in.

Short Load Duration, Resistance, and Deflection Data

Load (~ 3 sec.). 23.0 psf

Load Resistance: > 83.5 psf

Approximate center of edge deflection: 1.28 in.
Conclusion

Based on your design information, the load resistance is greater than or equal to
the specified loading.

Statement of Compliance

Procedures followed in determining the resistance of this window glass are in accordance with ASTM E1300-02/03.

Disclaimer:
This software can be used to determine the load resistance of specified glass types exposed to uniform lateral loads of short or long duration subject to the following conditions:
- The glass is free of edge and surface damage and has been properly glazed in the opening in conformance with the manufacturer's recommendations.
- Procedures exist to determine load resistance for rectangular glass assemblies that are:
a. Continuously supported aiong all four edges,
b. Continuously supported along three edges,
¢. Continuously supported along two parallel edges, and
d. Continuously supported along one edge.
- The software user has the responsibility of selecting the correct procedures for the required application from the software.
- The stiffness of members supporting any glass edge shall be sufficient that under design load, edge deflections shall not exceed L/175,
where L denotes that length of the supported edge.
- The non-factored ioad values for laminated glass are representative of test data and calculations performed for an interlayer at a temperature of 50° C (122° F).
For other limiting conditions that may apply, refer to Section 5 of ASTM E1300 and locat building codes.

Neither SDG nor PGMC guarantees and each disclaims any responsibility for any particular results relating to the use of the Window Glass Design 2004 Software Program.
SDG and PGMC disclaim any liability for any personal injury or any loss or damage of any kind, including all indirect, special, or consequential damages and lost profits,
arising out of or relating to the use of the Window Glass Design 2004 Software Program.

Prepared by: on 3/23/2006
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Glass Load Resistance Report --

Glazing Information Project Details
Edge Supports: 2 Sides Project Name:
Glazing Angle: 90° Location:

Lite Dimensions: Comments:

Unsupported Length: 96.0 in.
Supported Length:  48.0 in.

Glass Construction (Rectangular)

Single Glazed Lite { Fully Tempered }

Interlayer Type: PVB
Outboard Ply Thickness: 1/4 in.

Interlayer Thickness: 0.03in.
Inboard Ply Thickness: 1/4 in.
Nominal Thickness: 172 in.

Short Load Duration, Resistance, and Deflection Data

Load (~ 3 sec.):. 23.0 psf

Load Resistance: 33.0 psf

Approximate center of glass deflection: >1.97 in.
Conclusion

Based on your design information, the load resistance is greater than or equal to
the specified loading.

Statement of Compliance

Procedures foilowed in determining the resistance of this window giass are in accordance with ASTM E1300-02/03.

Disclaimer:
This software can be used to determine the load resistance of specified glass types exposed to uniform lateral loads of short or long duration subject to the following conditions:
- The glass is free of edge and surface damage and has been properly glazed in the opening in conformance with the manufacturer's recommendations.
- Procedures exist to determine ioad resistance for rectangular glass assemblies that are:
a. Continuously supported along all four edges,
b. Continuously supported along three edges,
c. Continuously supported along two paraliel edges, and
d. Continuously supported along one edge.
- The software user has the responsibility of selecting the correct procedures for the required application from the software.
- The stiffness of members supporting any glass edge shall be sufficient that under design load, edge deflections shall not exceed L/175,
where L denotes that length of the supported edge.
- The non-factored load values for laminated glass are representative of test data and calculations performed for an interlayer at a temperature of 50° C (122° F).
For other limiting conditions that may apply, refer to Section 5 of ASTM E1300 and local building codes.

Neither SDG nor PGMC guarantees and each disclaims any responsibility for any particular results relating to the use of the Window Glass Design 2004 Software Program.
SDG and PGMC disclaim any liability for any personal injury or any loss or damage of any kind, including all indirect, special, or consequential damages and lost profits,
arising out of or relating to the use of the Window Glass Design 2004 Software Program.

Prepared by: on 3/23/2006

Window Glass Design 2004 - Version [1.8] Copyright © 2002 SDG, Inc. Page 3 of 3



Glass Load Resistance Report -- Thursday, March 23, 20C

Statement of Compliance

Procedures foilowed in determining the resistance of this window glass are in accordance with ASTM E1300-02/03.

Disclaimer:
This software can be used to determine the load resistance of specified glass types exposed to uniform lateral loads of short or long duration subject to the following conditions:
- The glass is free of edge and surface damage and has been properly glazed in the opening in conformance with the manufacturers recommendations.
- Procedures exist to determine load resistance for rectangular glass assemblies that are:
a. Continuously supported along all four edges,
b. Continuously supported along three edges,
c. Continuously supported along two parallel edges, and
d. Continuously supported along one edge.
- The software user has the responsibility of selecting the correct procedures for the required application from the software.
- The stiffness of members supporting any glass edge shall be sufficient that under design ioad, edge deflections shall not exceed L/175,
where L denotes that length of the supported edge.
- The non-factored load values for laminated glass are representative of test data and calculations performed for an interlayer at a temperature of 50° C (122° F).
For other limiting conditions that may apply, refer to Section 5 of ASTM E1300 and local building codes.

Neither SDG nor PGMC guarantees and each disclaims any responsibility for any particuiar results relating to the use of the Window Glass Design 2004 Software Program.
SDG and PGMC disclaim any liability for any personal injury or any loss or damage of any kind, including all indirect, special, or consequential damages and lost profits,
arising out of or relating to the use of the Window Glass Design 2004 Software Program.

Prepared by: on 3/23/2006
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